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Getting Started 

What is Stratum.Connector? 
Stratum.Connector consists of easy to use windows for use in creating then managing the Analysis Services 
database and cube for Stratum.Viewer. Use it to: 

• Select the dimensions, hierarchies, levels, attribute relationships, measures, and partitions for 
Stratum.Viewer. 

• Create hierarchies from attribute relationships. 

• Make Stratum.Planner user lists and calculations available in Stratum.Viewer. 

Various types of administrative functionality are built into the application as well, such as registering or 
unregistering the Analysis Services database from Stratum.Viewer, processing updates made to roles in 
Stratum.Viewer, batch processing of dynamic user lists defined in Stratum.Viewer, and a system for sending email 
notifications related to database processing and Stratum.Viewer availability after processing. 
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Quick Start – Initial Setup of Application and Data 
Here is a high level look at the steps for initially setting up your Stratum.Connector Analysis Services database and 
cube. Before you proceed with this set up and perform an initial process of the database and cube, you need to 
make sure that Stratum.Server master file commands have been run and an OLAP parameter/switch has been 
enabled. See Run Master File Commands and Enable OLAP Parameter/Switch. 

 

Define the Stratum.Server Data Source 

• Right-click the Stratum.Server Data Source node , and select Define Stratum.Server Data 
Source. 

• Use the Define Stratum.Server Data Source window to specify the location and name of the 
Stratum.Server database that will be the data source. 

 
  
 

 

  

Define the Analysis Services Database 

• Right-click the Analysis Services Database node , and select Define Analysis Services 
Database. 

• Use the Analysis Services Database window to specify the Analysis Services database and 
cube properties. 
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Define the Stratum.Viewer Data Source 

• Right-click the name of the Analysis Services database , and select Configure 
Stratum.Viewer. 

• Then click New  in the Configure Stratum.Viewer window, and use the Define 
Stratum.Viewer Data Source window to specify the location and name of the Stratum.Viewer 
SQL Server database for use with this Stratum.Connector environment. 

 

  

 

Make Dimension Selections 

• Right-click the Dimensions node , and select Edit. 
• Use the Dimension Selection window to choose the dimensions, hierarchies, levels, and 

attribute relationships for your cube. 
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Make Measure Group Selections 

• Right-click the Measure Groups node , and select Edit. 
• Use the Measure Group Selection window to choose the measure groups, measures, 

partitions, and dimensions to make available in Stratum.Viewer. 

 
  

 

Make Calculated Member Selections 

• Right-click the Calculated Members node , and select Edit. 
• Use the Calculated Member Selection window to choose the calculated members for your 

cube. 

  

 

Customize Parameter Settings 

• Right-click the name of the Stratum.Connector SQL Server database , and select 
Parameters. 

• Use the Parameter Settings window to customize important settings including email 
notifications. To learn more about Email settings in this window, watch this Email Notifications 
Video. 

 
 
 

https://silvon.mystratum.com/?v=connectorvideo001
https://silvon.mystratum.com/?v=connectorvideo001
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Process the Database 

• Right-click the name of the Analysis Services database , and select Full. 
• Use the Full window to initiate a full process of the database. You will be asked to confirm that 

you want to proceed with a Full process. 

 

 

 

Tasks 

Define the Stratum.Server Data Source 

1.   Right-click the Stratum.Server Data Source node  in the main window, and select Define Stratum.Server 
Data Source. 

2.   In the Define Stratum.Server Data Source - Select Type window, choose the type of database that will be the 
data source – either SQL Server or DB2 for i. 

3.   Click Next. 

4.   Use the next screen that displays to enter the properties of your database. 

• SQL Server Properties - Enter the name of your Stratum.Server database and name of the SQL Server 
server on which it resides. 
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OR 

• DB2 for i Properties: 
• Enter the name of your Stratum.Server database and name of the IBM i server on which it resides. 
• Enter the directory entry of the database. 
• Enter the user name and password for Stratum.Connector to use whenever it needs to connect to the 

database. 
• Specify the Rowset Cache Size. 

5.   {Optional} Test the ability to connect to the database . 

6.   Click Finish. 

7.   Go to the next step in setting up the application. See Define the Analysis Services Database and Cube. 

Define the Analysis Services Database and Cube 

1.   Right-click the Analysis Services Database node  in the main window, and select Define Analysis Services 
Database. 

2.   Use the window that displays to specify the properties for your Stratum.Connector Analysis Services database 
and cube: 

• Server name 
• Database name 
• {Optional} Database description 
• Cube name 
• {Optional} Cube description 

3.   Save  the properties. 

4.   Go to the next step in setting up the application. See Define the Stratum.Viewer Data Source. 

Define the Stratum.Viewer Data Source 

1.   Right-click the name of the Analysis Services database  in the main window, and select Configure 
Stratum.Viewer. 

2.   Click New  in the Configure Stratum.Viewer window. 

3.   In the Define Stratum.Viewer Data Source window that displays: 

• Enter the name of your Stratum.Viewer database (the data source) and name of the SQL Server server on 
which it resides. 

• {Optional} Test the ability to connect to the database . 
• Click OK. 

4.   {Optional} Select the Process User Lists option to make the Stratum.Planner user lists available in 
Stratum.Viewer. If you also want the migrated user lists to be maintainable via Stratum.Viewer, select the 
Maintain In Viewer option. 
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5.   Save  the properties. 

6.   Go to the next step in setting up the application. See Make Dimension Selections. 

Make Initial Dimension Selections 

1.   Right-click the Dimensions node , and select Edit to open the Dimension Selection window. 

2.   Select the dimensions and related objects for your database -- the hierarchies, levels, and attribute 
relationships. Optionally edit the properties of objects as you select them. 

• Selecting a dimension automatically selects all of its hierarchies, levels, and attribute relationships. 
• Expand  the nodes for a dimension, hierarchy, and level if you need to review selections and de-select 

any of the automatically-selected objects. 
• See also Create Hierarchies from Attribute Relationships. 

3.  Save  the changes and close  the window. 

4.  Go to the next step in setting up the application. See Make Measure Group Selections. 

Make Initial Measure Group Selections 

1.   Right-click the Measure Groups node , and select Edit to open the Measure Group Selection window. 

2.   Select the measure groups and related objects for your database -- the partitions, dimensions, and measures. 
Optionally edit the properties of measures as you select them. 

• Selecting a measure group automatically selects all of its partitions, dimensions, and measures. 
• If Stratum.Viewer users will need to perform planning on measures from this group, select the Update 

Enabled option for the measure group. See also Impact of Update Enabled Setting on Roles and Planning 
in Stratum.Viewer. 

• Expand  the nodes for measure groups, partitions, dimensions, and measures if you need to review 
selections and de-select any of the automatically-selected objects. 

3.   Save  the changes and close  the window. 

4.   Go to the next step in setting up the application. See Make Calculated Member Selections. 

Make Initial Calculated Member Selections 

1.   Right-click the Calculated Members node , and select Edit to open the Calculated Member Selection 
window. 

2.   Select the calculated members for your database. Optionally edit the name, description, or format string as you 
select each member. 

3.   Save  the changes and close  the window. 

4.   Go to the next step in setting up the application. See Customize Parameter Settings. If you are not customizing 
the settings, go to the final step. See Process the Database. 
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Customize Parameter Settings 

 1.  Right-click the name of the Stratum.Connector SQL Server database  in the main window, and select 
Parameters. 

2.  Use tabs in the Parameter Settings window to customize the following properties. To learn more about Email 
settings in this window, watch this Email Notifications Video. 

     General 

• Enable Group By for Detail Flip-up Views – Controls whether or not the Stratum server database engine 
will apply an aggregation on the result set and send less data to the Analysis Services server to process. 
The option is enabled by default.   

• Automatically Select New Dimensions - Enable this option if you want all dimensions that are added 
after the initial Analysis Services database set up to be automatically selected for all applicable measure 
groups. The selections pertain to the Measure Group Selection window and will be made for you once the 
database is processed again. 

• Add Missing Members for User Controlled Data - Controls if Connector processes will check for and add 
missing Master File records that are needed to support user controlled data functionality such as 
Stratum.Viewer’s Data Import. If your company has implemented user controlled data functionality, enable 
this parameter. If not, then this parameter can be disabled. By default, the parameter is enabled. 

Note:  This parameter only applies to Stratum Server SQL Server implementations. 

• Currency Dimension Name - Use to customize the name of that dimension. 
• Registration Key - If a valid key is not associated with your copy of Stratum.Connector, you will need to 

enter a key using this property. 
• Default Process Type – This setting controls the default process type that will be initiated when 

Stratum.Connector updates are processed in batch and a process type is not specified. Batch processes 
are typically executed on a nightly basis in order to update the Analysis Services database and cube with 
the most recent data from Stratum.Server. While setting up a batch process, you can override this default – 
see the topic Batch Command Parameters for Silvon.Connector.exe. 

Note: Keys are required for licensed copies of Stratum.Connector. If you receive a message about a missing, 
invalid, or expired key, contact Silvon Support at (800) 474-5866 or CustomerSupport@silvon.com. 

• Process Pending User Controlled Attribute Update – Properties in this section determine how pending 
changes for attributes added or edited in Stratum.Viewer are treated by Limited and Standard processes. 
These attributes are known as User Controlled Attributes. Setting a process type to No means it will not 
process any pending changes. Setting a process type to Yes means pending changes will be processed. 
The process will check for pending changes then switch to a Full process if changes are found so all 
changes can be processed. 

Note: Only set the properties to Yes in situations where it is okay if the Limited or Standard process is switched to 
Full process (a Full process means users won’t be able to access views in Stratum.Viewer until after the process is 
completed). 

     Key Errors 

• Stop Processing On Key Errors - Select if you want Stratum.Connector to stop processing the Analysis 
Services database when it finds a dimension value (members) in the Stratum.Server database for which no 

https://silvon.mystratum.com/?v=connectorvideo001
mailto:CustomerSupport@silvon.com
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Master File information exists. If you leave this checkbox de-selected, processing will continue until the Key 
Error Limit is reached.  

• Key Error Limit - Use to specify how many key errors can occur before database processing will be 
stopped. For example 0 (zero), 10, 20, etc. This field is enabled only if the stop processing option has been 
selected. 

     Emails (watch video) 

• SMTP Server Name - Use this field to determine how Stratum.Connector will deliver emails -- either using 
the SMTP configurations for the server where Stratum.Connector resides (localhost) or by another SMTP 
server that you specify (enter the server name in a format that will be recognized by your network, such as 
the server name or IP address). 

• Email From Address - Specify the email address that will act as the “From” sender for Connector emails. 
• Email Notification Properties - Specify the To Address, Subject, and Body properties for each of the 

different email notifications that Connector sends out. The type of email sent depends on the outcome of 
the Connector process (see below). If you enter multiple email addresses in a To field, use commas or 
semi-colons to separate the addresses. By default, the relevant log file for the process will be attached to 
the email unless you select No for an email’s Attach Process Log property. 

• Process Complete - Cube Available: The email is sent when a process completes and the 
database is available. 

Note: When a Limited or Trickle process completes but encounters an error that prevents the cube 
from being updated, the cube remains available to users. In this case, Connector will append a 
‘Process failed with an error’ note to the Subject of your email message to indicate that while the 
cube is available, the updates failed.   

• Process Complete - Cube Locked: The email is sent when a process completes, but the 
database is locked. 

• Key Errors Occurred: The email is sent when key errors occurred and were logged during the 
processing of the database. 

• User Controlled Attribute Update Notification: The email is sent when a Stratum.Viewer user 
has added, made changes to, or deleted a User Controlled Attribute via that application’s User 
Controlled Attribute Maintenance functionality. The email tells the recipient a Full process may be 
required in Connector to process the changes. 

Log Files 

• Process Log Verbosity - By default, this is set to Normal, which means your logs will include process start 
and finish times as well as details about what objects were processed. If you need more detailed 
information, change this option to Debug. In that case, more detailed information will be included in the 
processing logs. 

• Override Locations - Optionally change the location of any of the three types of log files listed in this tab. 
By default, log files are stored in the Log folder of the Stratum.Connector main application folder. You can 
separately control the location of the Process Log (log for Full, Standard, Trickle, and so forth), Key Error 
Log, and Post Process Temp log. To change any of these properties, select the checkbox for that log 
then enter the desired location and name.  

3.  Save  the changes and close  the window. 

4.  If you are setting up the database for the first time, continue with any remaining steps for setting up the 
application -- see Quick Start - Initial Setup of Application and Data. If you are editing the database, see When 
to use a Full, Limited, Post, Standard, or Trickle Process to determine what type of database process to run 
after making your changes. 

 

https://silvon.mystratum.com/?v=connectorvideo001
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Process the Database 

 When you are done with the initial setup of the application and data, initiate a Full process. 

1.    Right-click the name of the Analysis Services database  in the main window, and select Full. 

2.    Click Start in the Full window that displays. 

3.    Confirm that you want to proceed with a full process. 

 

4.   After the process has completed, close the Full window. 
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Windows 

Analysis Services Database Window 

 

 

Menus and Toolbar - There are standard File and Help menus at the top of selection windows. Use 
options on the File menu or the icons below it to save edits in  or close  a window. Use options 
on the Help menu to access the help file or version information about Stratum.Connector. 

 

Server Name - Enter the name of the Analysis Services server for the Analysis Services database. 

 

Database Name and Database Description - Enter an Analysis Services database name. Choose a 
unique and meaningful name that will let you easily identify this database from other Analysis Services 
databases on the server and help you easily see which implementation of Stratum.Connector and 
Stratum.Viewer to which it pertains. Entering a description is optional. 

 

Cube Name and Cube Description - Enter a cube a name. Choose a unique and meaningful name 
that will let you easily identify this cube. Entering a description is optional. 
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Calculated Member Selection Window 

 

 

Menus and Toolbar - There are standard File and Help menus at the top of selection windows. Use 
options on the File menu or the icons below it to save edits in  or close  a window. Use options 
on the Help menu to access the help file or version information about Stratum.Connector. 

 

Calculated Members - This section displays any Stratum.Administration calculations that exist for the 
measures selected in the Measure Group Selection window. 

• Individual Members - Use the checkboxes of individual calculated members to add or 
remove them. 

• Select/Deselect All - Use this checkbox to select or deselect all members at once. 

 

Calculated Member Properties - Click a calculated member to see its properties. All properties can 
be edited except for the Expression, which is read only. 
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Note: All properties will remain disabled in the case of calculated members that haven't been selected 
for your database. 

• Name and Description - Defaults to the Stratum.Administration name and description. 
• Expression - Displays the Stratum.Administration expression for the calculated member. 
• Format String - Defaults to the member's Stratum.Administration format. This property 

determines the default format for this member when used in Stratum.Viewer. 

Configure Stratum.Viewer Window 

 

 

Menus and Toolbar - There are standard File and Help menus at the top of selection windows.  

Use options on the File menu or the icons below it to carry out the following actions. 

• New  - Click to open the Define Stratum.Viewer Data Source window and define the 
Stratum.Viewer database (the data source) for use with your Stratum.Connector 
implementation. Once you have configured a Stratum.Viewer database to 
Stratum.Connector, certain types of updates and actions will be carried out with each process 
of the Analysis Services database. Those actions include registering the Analysis Services 
database in Stratum.Viewer, batch processing of Stratum.Viewer dynamic user lists, and 
updating Stratum.Viewer roles in the Analysis Services database. The New icon will be 
grayed out once you define a database. 

• Edit  - Click when you edit information about the Stratum.Viewer database that has been 
defined as the data source. For example, if the location (SQL Server server) for it has 
changed. The Edit icon opens the Define Stratum.Viewer Data Source window.   

• Save  - Click to save changes made to the user list properties in the window.  
• Delete  - Click to delete the currently defined connection properties between 

Stratum.Connector and the Stratum.Viewer database. You will be prompted to confirm the 
deletion. This task does not delete the database, but it does remove all Stratum.Connector 
properties required for it to connect to and update the database.   
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• Exit  - Click to close the window. 

Use options on the Help menu to access the help file or version information about Stratum.Connector. 

 

Stratum.Viewer Server and Database - This section displays the name of the SQL Server server 
where your Stratum.Viewer database resides and the name of the database. The section is populated 
with that information once you define the Stratum.Viewer database. You can click the name and then 
an icon at the top of the window to carry out certain tasks, such as an Edit or Delete. 

 

Properties - The properties in this section are used to control whether or not Stratum.Planner user 
lists will be available in Stratum.Viewer.  

• Process User Lists - Select this checkbox if you want the user lists to be available in 
Stratum.Viewer. Lists will be migrated into Stratum.Viewer when the Analysis Services 
database is processed by Stratum.Connector. When additional database processes occur in 
the future, after the initial migration, Stratum.Connector will check for and migrate any new 
Stratum.Planner user lists. The application also continues to migrate all attributes for 
previously migrated lists. This means attribute changes made in Stratum.Planner will be 
reflected in the lists when they are used in Stratum.Viewer. Attributes that are migrated 
include members and user list properties such as description and their global or personal 
type. Stratum.Connector also checks that lists meet the following condition. This check 
makes sure lists will function in Stratum.Viewer. The condition is: 
• The Owner ID associated with the user lists in Stratum.Planner is a valid User ID in 

Stratum.Viewer. 
• Maintain In Viewer - This checkbox is available for use only when the Process User Lists 

checkbox has been selected. Otherwise, the checkbox is grayed out and inactive. If Maintain 
in Viewer is selected, after the initial migration, these user lists will no longer be updated by 
Stratum.Connector. They can only be maintained via Stratum.Viewer. 
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Define Stratum.Server Data Source Window 

Select Type Screen 

 

 

Select an option for the type of Stratum.Server database (the data source) that you are using, either 
SQL Server or DB2 for i. 
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SQL Server Properties Screen 

 

 

Server Name and Database Name - Enter the name of your Stratum.Server database and name of 
the SQL Server server on which it resides. 

 

Test Connection - Use this button to test the ability to connect to the Stratum.Server database. 
Stratum.Connector will attempt to connect to the specified Stratum.Server database using the 
Windows credentials of the person currently using the application. 

You will be provided with a Connection Succeeded message if the connection is successful. You will 
be provided with a Connection Failed message if a connection cannot be made (for example, if the 
person currently using the application doesn't have permission to access the database). Additional 
validations occur when you click Finish, such as verifying that the GILOADOLAP and GICRTOMAST 
Stratum.Server programs have been run for the database. See also Run Master File Commands and 
Enable OLAP Parameter/Switch.  
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DB2 for i Properties Screen 

 

 

Server Name and Database Name - Enter the name of your Stratum.Server database and name of 
the IBM i server on which it resides. 

 

Directory Entry - Enter the directory entry of your Stratum.Server database. 

 

User Name and Password - Enter a user name and password for Stratum.Connector to use 
whenever it needs to connect to the database. 

 

Rowset Cache Size - Optionally customize the rowset cache size. This property impacts how many 
rows of data are pre-fetched by the Microsoft OLE DB Provider for DB2 provider during data retrieval 
for Stratum.Connector. The property can be set to a value in the range of 0 to 200. This property is 
valid only for a SQL Server 2008 R2 Enterprise edition or SQL Server 2012 Enterprise edition 
implementation. 

 

Test Connection - Use this button to test the ability to connect to the Stratum.Server database. 
Stratum.Connector will attempt to connect to the specified Stratum.Server database using the 
specified user name and password. 

You will be provided with a Connection Succeeded message if the connection is successful. You will 
be provided with a Connection Failed message if a connection cannot be made (for example, if the 
person currently using the application doesn't have permission to access the database). Additional 
validations occur when you click Finish, such as verifying that the DALOADOLAP and 
DACRTOMAST Stratum.Server programs have been run for the database. See also Run Master File 
Commands and Enable OLAP Parameter/Switch. 
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Define Stratum.Viewer Data Source Window 

 

 

Server Name and Database Name - Enter the name of your Stratum.Viewer database (the data 
source) and name of the SQL Server server on which it resides. 

 

Test Connection - Use this button to test the ability to connect to the Stratum.Viewer database. 
Stratum.Connector will attempt to connect to the specified Stratum.Viewer database using the 
Windows credentials of the person currently using the application. 

You will be provided with a Connection Succeeded message if the connection is successful. You will 
be provided with a Connection Failed message if a connection cannot be made (for example, if the 
person currently using the application doesn't have permission to access the specific server and/or 
database). 
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Dimension Selection Window 

 

 

Menus and Toolbar - There are standard File and Help menus at the top of selection windows. Use 
options on the File menu or the icons below it to save edits in  or close  a window. Use options 
on the Help menu to access the help file or version information about Stratum.Connector. 

 

Dimension(s) - Use this section to select or de-select the dimensions and related objects for your 
database -- the hierarchies, levels, and attribute relationships. 

• Individual Objects - Expand  the nodes for objects to see subsequent nodes or detail for an 
object. Then use the checkboxes of individual dimensions, hierarchies, levels, or attribute 
relationships to add or remove them. Checkboxes of objects belonging to the same dimension 
are interdependent, and the window will automatically select or de-select related objects for 
you as you use the checkboxes. For example:  

• Selecting a dimension automatically selects all of its hierarchies, levels, and attribute 
relationships. 

• De-selecting a hierarchy automatically de-selects its level plus the dimension to which it 
belongs. 

• Selecting a level automatically selects its attribute relationships plus the hierarchy and 
dimension to which it belongs.  
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• Select/Deselect All - Use this checkbox to select or deselect all objects in the window at 
once. 

 

Properties - Click on a dimension, hierarchy, or level to see their properties and edit them. Click an 
attribute relationship to edit its properties or create a hierarchy from it. 

Note: All properties will remain disabled in the case of objects that haven't been selected for your 
database. 

• Dimensions , Hierarchies , and Levels - You can change the name and description, 
which default to their Stratum.Planner name and description. 

• Attribute Relationships, Corporate Controlled  - Attribute values originating from 
Corporate business systems and that are stored in your Stratum.Server database and 
maintained in Stratum.Connector are known as Corporate Controlled. They have an Attribute 
Controlled By status of Corporate, which shows in the bottom of the Dimension Selection 
window. In Connector, you can do the following:  

• Change the name, which defaults to the Stratum.Planner name.  
• Use the Create Hierarchy checkbox to create a hierarchy from the attribute 

relationship. The Hierarchy Name field only displays when the checkbox is selected. 
Selecting “Create Hierarchy” will create a new hierarchy with the specified name. This 
new hierarchy will be part of the associated dimension and can be used to display 
data in the Stratum.Viewer grid the same as other hierarchies. Security defined for the 
associated dimension will be applied to this new hierarchy. The new hierarchy will be 
available to Stratum.Viewer users after the next Analysis Services cube process. 

• Remove a previously created hierarchy on it. Click the related attribute relationship 
and then de-select the Create Hierarchy checkbox. The next cube process will remove 
all references to this hierarchy from Stratum.Viewer. 

• De-select it, which makes it unavailable in Stratum.Viewer after the next Full process. 

 

• Attribute Relationships, User Controlled  - Attribute values originating from an Excel 
Spreadsheet and that are updated using Stratum.Viewer Master Data Import functionality 
functionality* are known as User Controlled. They are defined using Stratum.Viewer User 
Controlled Attribute Maintenance. They have an Attribute Controlled By status of User 
Controlled, which shows in the bottom of the Dimension Selection window. 

• In Connector, you can view their properties including seeing any hierarchy created 
from the attribute.   

• Any type of maintenance such as property changes, deletion, or creating hierarchies 
from this type of attribute relationship must be done in Stratum.Viewer’s Attribute 
Maintenance. 

*Note: User Controlled Attribute Maintenance functionality is only available for implementations 
running Stratum.Server on a Windows SQL server and that have a license for the Stratum Analyst 
Hub. It is not available for implementations running Stratum.Server on an IBM i Server – the Attribute 
Controlled By property is always Corporate for those types of implementations.  
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Main Window 

 

 

Main Node  and Toolbar - The main node in this window displays the name of the server for the 
SQL Server database that was defined for Stratum.Connector at the time of installation. The 
database name is listed after the server name. 

If you need to adjust parameter settings for the application, right-click this node and select 
Parameters. See also Customize Parameter Settings. 

 
The main toolbar has a File menu with an option for exiting the application and a Help menu with 
options for accessing the help file or version information about Stratum.Connector. 

 

Stratum.Server Data Source  - Right-click this node and select Define Stratum.Server Data 
Source to specify the Stratum.Server databases for your Stratum.Connector environment. See also 
Define the Stratum.Server Data Source and Define Stratum.Server Data Source window. 

 

After a data source has been specified, an icon  displays under this node followed by the name of 
the server and database for the related data source. 
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Analysis Services Database  - Right-click this node and select Define Analysis Services 
Database to set up the Stratum.Connector Analysis Services database and cube. See also Define the 
Analysis Services Database and Cube and Analysis Services Database window. 

 

After a database and cube have been set up, an icon  displays under this node followed by the 
name of the Analysis Services server for the database, the Analysis Services database name, and 
the cube name. You can right-click that entry to access the following menu. The menu options and 
the Dimensions, Measure Groups, and Calculated Members entries are defined after this image. 

 

• Define Analysis Services Database - Use this option to re-access the Analysis Services 
Database window if you need to review the database or cube properties, such as their 
descriptions, after initially setting them up. 

• Diagnostic, Full, Limited, Post, and Standard Process - Use the applicable option to 
select the type of process that you want to initiate -- a Diagnostic, Full, Limited, Post, or 
Standard process.* The window for starting the type of process that you selected will display.  

*Note: A Trickle process can only be initiated by a batch process and therefore does not display on 
this window. 

• Configure Stratum.Viewer - Use this option to access the Configure Stratum.Viewer 
window, which is used to register the Analysis Services database and cube to a 
Stratum.Viewer environment. The window also is used to control a few options related to 
using Stratum.Planner user lists in the Stratum.Viewer environment. It is from this window 
that you can access the Define Stratum.Viewer Data Source window. See also Define the 
Stratum.Viewer Data Source. 

• Unregister - Use this option to unregister the Analysis Services database and cube from the 
Stratum.Viewer application that is configured to your Stratum.Connector environment. This 
action also deletes the definitions for related objects in Stratum.Viewer, such as roles, views, 
and user lists. 

Use these entries under the Analysis Services Database node to select and manage the objects for 
your cube. 

• Dimensions  - Right-click and select Edit. This opens the Dimension Selection window, 
which is used to control which dimensions, hierarchies, levels, and attribute relationships are 
a part of your cube. The window also is used to create hierarchies from attribute 
relationships. 
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• Measure Groups - Right-click and select Edit. This opens the Measure Group Selection 
window, which is used to control which measures, partitions (years), and dimensions are 
available for the measure groups in your cube. 

• Calculated Members  - Right-click and select Edit. This opens the Calculated Member 
Selection window, which is used to control which Stratum.Administration calculated category 
values are included as calculated members in your cube. 

Measure Group Selection Window 

 

 

Menus and Toolbar - There are standard File and Help menus at the top of selection windows. Use 
options on the File menu or the icons below it to save edits in  or close  a window. Use options 
on the Help menu to access the help file or version information about Stratum.Connector. 
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Measure Groups - Use this section to select or de-select the measure groups and related objects for 
your database -- the partitions, dimensions, and measures. 

• Individual Objects - Expand  the nodes for objects to see subsequent nodes or detail for 
an object. Then use the checkboxes of individual partitions, dimensions, or measures to add 
or remove them. Checkboxes of objects belonging to the same measure group are 
interdependent, and the window will automatically select or de-select related objects for you 
as you use the checkboxes. For example:  

• Selecting a measure group automatically selects all of its partitions, dimensions, and 
measures. 

• De-selecting a partition that is the only one selected for a Partitions node automatically 
de-selects that node. The other nodes within a measure group behave the same. 

• Selecting a Measures node automatically selects all the measures in that node.  

• Select/Deselect All - Use this checkbox to select or deselect all objects in the window at 
once. 

The prior image shows an example of an expanded Measures node, in this case for a Daily Sales 
measure group. Here are examples of the expanded Partitions and Dimensions nodes for that group. 
Note that Stratum.Viewer will only display data for the measures selected from a group in relation to 
the selected partitions and dimensions. For example, data from the 2015 partition would not display 
for Daily Sales in Stratum.Viewer if that partition wasn’t selected for it in Stratum.Connector. 

  

 

Measure Group Properties – If you click a measure group, an Update Enabled checkbox displays at 
the bottom of this window. The checkbox is deselected by default. Selecting the checkbox makes its 
measures Planning Enabled in Stratum.Viewer, which is a pre-requisite for other steps in setting up 
Planning features in Stratum.Viewer. Stratum.Viewer administrators can then allow measures in the 
group to be edited in planning views and give users Update authority to measures in the group for 
planning purposes.  

Also, the unique ID associated with this group displays at the bottom of the window. Above the ID is a 
read-only property named Data Controlled By. That property reflects the status of a category 
maintenance property in Stratum.Viewer, and the status will either be Corporate or User. If the 
property is set to "User" in Viewer, then users will be able to import data into measures belonging to 
the applicable category (measure group) through Data Import* functionality. The source of data for 
categories with a Corporate designation will exclusively be your corporate data system, for example 
your ERP or CRM. Those categories cannot be updated with Data Imports. 

*Note: Data Import is only available for implementations running Stratum.Server on a Windows SQL 
server and that have a license for the Stratum Analyst Hub. Data Import is not available for 
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implementations running Stratum.Server on an IBM i Server – the Data Controlled By property is 
always Corporate for those types of implementations.  

Measure Properties – If you click an individual measure in the group, you will see its properties at the 
bottom of this window. All properties can be edited. 

Note: All properties will remain disabled in the case of measures that haven't been selected for your 
database and in the case of partitions and dimensions. 

• Name and Description - Defaults to the Stratum.Planner name and description. 

• Format String - Defaults to the measure's Stratum.Planner format. This property determines 
the default format for this measure when used in Stratum.Viewer. 
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Parameter Settings Window 

 

 

Menus and Toolbar - There are standard File and Help menus at the top of selection and settings 
windows. Use options on the File menu or the icons below it to save edits in  or close  a 
window. Use options on the Help menu to access the help file or version information about 
Stratum.Connector. 

 
Settings Tabs - There are tabs to control specific aspects of Connector including the emails and log 
files it will generate when it processes related databases. See the sections that follow for details 
about each tab. It is important to review and set up properties specific to your implementation and 
preferences. Click a tab name below to learn about its purpose. 

• General tab 

• Key Errors tab 

• Emails tab 

• Log Files tab 

 

  



28                                                                                                                                     Initial Setup of Application and Data 

 

General Tab 
Use this tab to control general properties for the Stratum.Connector for Analysis Services database and to enter the 
registration key for your Connector license. 

 

 

• Enable Group By for Detail Flip-up Views – Controls whether or not the Stratum server 
database engine will apply an aggregation on the result set and send less data to the Analysis 
Services server to process. The option is enabled by default.   

• Automatically Select New Dimensions - Over time, after you have already set up your 
Stratum.Connector Analysis Services database/cube, you may decide to add more dimensions 
by selecting additional ones in the Dimension Selection window. If you want all the newly added 
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dimensions to be selected for all applicable measure groups that are a part of the database, you 
can have Stratum.Connector make the selections automatically. The selections will be made 
once the database is processed. You can enable that option by selecting the Automatically Select 
New Dimensions checkbox on this General tab. 
If Automatically Select New Dimensions is de-selected, you will need to manually select the 
dimensions using the Measure Group Selection window. Manually selecting the dimensions may 
be preferred if you want the newly added dimensions selected for just some of your measure 
groups rather than all measure groups. 

• Add Missing Members for User Controlled Data – Controls if Connector processes will add 
any missing Master File records that are needed to support user controlled data functionality 
such as Stratum.Viewer’s Data Import. If your company has implemented user controlled data 
functionality, then this parameter should be selected. If that type of functionality isn’t being used, 
then this parameter can be deselected. This parameter is considered by all Full, Standard, 
Limited, Trickle, and Post processes in Connector.   

Note:  This parameter only applies to Stratum Server SQL Server implementations. 
• Currency Dimension Name - This field controls the name given to the currency dimension that 

Stratum.Connector creates while processing your Analysis Services database and cube. 
Customizing the name is optional. 

• Registration Key – A valid registration key is required for licensed copies of Stratum.Connector. 
If you receive a message about a missing, invalid, or expired key, then you need to contact 
Silvon Support at (800) 474-5866 or CustomerSupport@silvon.com. 

• Default Process Type – This setting controls the default process type that will be initiated when 
Stratum.Connector updates are processed in batch and a process type is not specified. Batch 
processes are typically executed on a nightly basis to update the Analysis Services database and 
cube with the most recent data from Stratum.Server. Types of processes are Diagnostic, Full, 
Limited, Post, and Standard. While setting up a batch process, you can override this setting – see 
the topic Batch Command Parameters for Silvon.Connector.exe. 

 

• Process Pending User Controlled Attribute Update – Properties in this section determine how 
pending changes for attributes added or edited in Stratum.Viewer are treated by Limited and 
Standard processes. These attributes are known as User Controlled Attributes. Setting a process 
type to No means it will not process any pending changes. Setting a process type to Yes means 
pending changes will be processed. The process will check for pending changes then switch to a 
Full process if changes are found so all changes can be processed. 

Note: Only set the properties to Yes in situations where it is okay if the Limited or Standard process 
is switched to Full process (a Full process means users won’t be able to access views in 
Stratum.Viewer until after the process is completed). 

 

  

mailto:CustomerSupport@silvon.com
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Key Errors Tab 
Use this tab to control whether or not Stratum.Connector will stop processing the Analysis Services database if key 
errors occur during processing. A key error occurs when Stratum.Connector finds a dimension value (members) in 
the Stratum.Server database for which no Master File information exists. 

See also the description of the Log Files tab, which includes a property for customizing the location and name of 
the log file that captures key errors. 

 

 

• Stop Processing On Key Errors - This option is selected by default, which means processing 
will be stopped when the Key Error Limit has been reached. Error information will be written to 
the Key Error Log file. The Key Error Limit is described later in this topic and determines how 
many key errors can occur before processing will be stopped (for example,1, 20, etc.). When 
processing is stopped, your Analysis Services database and cube will be locked. This prevents 
data from being used in Stratum.Viewer until the errors can be corrected and the database is 
processed successfully. Once a set of errors is fixed, you can initiate the database processing 
again. If the Key Error limit is reached again, processing will be stopped again so you can fix that 
set of errors and once again initiate database processing. 
 
If you de-select this option, database processing will continue regardless of any key errors that 
occur. Error information will be accumulated in the Key Error Log file. When processing is done, 
your Analysis Services database and cube will be locked until you correct the key errors and the 
database is processed successfully. 

• Key Error Limit - Use to specify how many key errors can occur before database processing will 
be stopped. For example, when Stop Processing on Key Errors is selected and the Key Error 
Limit is set to 0 (zero), then processing will stop at the first error that occurs. Or, if Stop 
Processing on Key Errors is selected and the Key Error Limit is set to 20, then processing will 
stop if twenty errors occur. This field is disabled when Stop Processing on Key Errors is de-
selected.   
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Emails Tab 
Use this tab to control properties for the emails that Stratum.Connector for View generates to keep administrators 
informed about the status of processing the Analysis Services database and cube. Settings for each type of email 
also allow you to determine if copies of log files for a process will be attached to the email that is generated. 

To learn more about Email settings, watch this Email Notifications Video. 

 

 

• SMTP Server Name - The value specified in this field indicates how Stratum.Connector will 
deliver these emails. The field defaults to a “localhost” value. That means the email will be 
delivered using the SMTP configurations for the server where Stratum.Connector resides. If you 
plan to use a different SMTP server, enter that server name in the SMTP Server Name field. 

https://silvon.mystratum.com/?v=connectorvideo001
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Enter the server name in a format that will be recognized by your network. For example, the 
server name or IP address or in the format of server name.networkname.com. 

• Email From Address - Specify the email address that will act as “From” sender of emails that 
Connector generates as a result of processing. 

 

Four different types of emails can be generated by Stratum.Connector after a process. Emails are a 
means of notifying recipients that a process occurred and optionally giving them a copy of the log file 
for the process or potential key errors related to a process. Filling in these properties is required for 
Connector to send out any emails. 

For each of the email types available, you need to specify the Email To Address, Email Subject, 
and Email Body. If you enter multiple email addresses in an Email To field, use commas or semi-
colons to separate the addresses. By default, for each type of email the applicable log file for the will 
be attached to its email unless you change an email’s Attach Process Log property to No. 

The three types of emails are: 

• Process Complete - Cube Available: The type of email sent when a process completes and the 
database is available for user with Stratum.Viewer. 

Note: When a Limited or Trickle process completes but encounters an error that prevents the cube 
from being updated, the cube remains available to users. In this case, Connector will append a 
‘Process failed with an error’ note to the Subject of your email message to indicate that while the 
cube is available, the updates failed.   

• Process Complete - Cube Locked: The type of email sent when a process completes, but the 
database is locked from being used with Stratum.Viewer. 

• Key Errors Occurred: The type of email sent when key errors occurred and were logged during 
the processing of the database. 

• User Controlled Attribute Update Notification: The email is sent when a Stratum.Viewer user 
has added, made changes to, or deleted a User Controlled Attribute via that application’s User 
Controlled Attribute Maintenance functionality. The email tells the recipient that a Full process 
may be required in Connector to process the changes. 
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Log Files Tab 
Use this tab to customize properties for log files that Stratum.Connector for View generates for different types of 
processing or processing outcomes (for example, to log key errors). 

 

 

Process Log Verbosity – Controls the type of information logged in log files related to the 
processing of your Analysis Services database and cube. By default, verbosity is set to Normal, 
which means your logs will include the times a process started and finished as well as details about 
what objects were processed. If you need more detailed information such as when debugging a 
processing error, change this option to Debug. In that case, information to aid in understanding what 
happened during a process that ended in an error will be retrieved and displayed in the processing 
logs. 

 

Override Locations – By default, log files for database processing are stored in the Log folder of the 
Stratum.Connector main application folder. You can customize the location of any of the three types 
of log files listed in this tab. Select the checkbox of the log file type that you want to customize 
settings for, and enter your override changes for that log. 
The log file locations you can override are: 

• Process Log Folder – The location of the log containing general details about what was 
processed and when during a batch process (Full, Standard, Limited, and so forth).  

• Key Error Log Folder – The location of the log file for Key Errors. See the description of the Key 
Errors tab for more details. 

• Post Process Temp Folder – The location of a text file specific to the Post Process phase of 
database process (the MembersN table updates).  

 

 



34                                                                                                                                     Initial Setup of Application and Data 

Processing Windows 

 

 

Title Bar - The type of process that you selected from the main window displays in the title bar -- 
either Full, Limited, Post, Standard, or Diagnostic process. 

 

Start / Stop - Start initiates the process. Use the Stop button to cancel a process.   

When you start a Full process, you will be asked to confirm that you want to proceed with it. 

 
Confirmation messages will not display when you start other types of processes. A Diagnostic, 
Limited, Post, or Standard process will begin as soon as you click Start in their processing windows. 

After a process is completed, Connector will also send out emails and a copy of the relevant log file 
based on settings in the Emails tab of the Parameter Settings window. 
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Log Information - The main area of this window displays general information about the process. 
Information logged includes general information such as the application version and names of the 
Analysis Services database, Stratum.Server database, and their servers. For a Full, Limited, Post, or 
Standard process, additional information displays in the window – that detailed information includes 
the date and time when each line item for the process was started and completed and line items 
regarding the overall successful completion or errors in the process. 

Typically log information does not appear in this window until the process has completed. Thus, 
another option for viewing log information during processing is to open log files from the Log folder in 
the application directory. Log files can also be attached to emails that notify you when a process has 
been completed. See the topic Customize Parameter Settings for information about setting up those 
emails. 

 

Advanced Concepts 

Account For Viewer Planning & Master Data Import In Consolidation Writeback Process 
If you are using Master Data Import and the Planning application to update the Stratum warehouse, make sure that 
your custom Consolidation Writeback process for Connector runs the LOADOLAP and CRTOMAST commands.   

• Master Data Import allows users to import data for dimension key values that don’t exist in a Mast table.  
When a key value does not exist, then a key value will be added to the UCA Master and MembersN tables.  

Note:  The dimension key value is NOT added to the MASTER and MAST tables.   

• Once the dimension key value is added using Master Data Import, users can add planning data for that key 
value. This means that there will be transactions in the Planning Writeback tables for key values that don’t 
exist in the Mast table. 

• The custom Consolidation Writeback process for Connector needs to run the LOADOLAP and CRTOMAST 
commands so that any new dimension key values will be properly added to the Mast table.           

 Batch Command Parameters for Silvon.Connector.exe  
A Full, Standard, Post, Limited, or Diagnostic process can be initiated using the right click menu of the Analysis 
Services database in the Stratum.Connector application. Any of those process types also can be initiated by 
including the Stratum.Connector application file* as part of a batch command. A Trickle process can only be 
initiated that way. The batch command can be run a variety of ways including through scheduled tasks set up in 
third-party scheduling tools or SSIS Scripts.  

*Note: The application file is an executable file named Silvon.Connector.exe. It resides in the main folder of the 
application directory to which Stratum.Connector was originally installed.  

Batch Command Parameters for Silvon.Connector.exe 
Keep in mind these requirements when using the parameters:  

• Specify the main parameters in the order of /batch /ProcessType: 
• A space must be used between each parameter. 
• Remember to use a colon (:) after the names of all parameter types below other than the /batch command 

parameter. 
• If any values for your parameters contain spaces, you will need to enclose the parameter and its values in 

double quotes. For example, “/CubeLockedEmailBody: Here is the Connector log for the most recent 
Limited process”. 
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• If you use any of the EmailToAddress parameters and specify multiple email addresses, use semi-colons to 
separate the addresses. For example, if you use the /CubeLockedEmailToAddress parameter and specify 
multiple email addresses, use semi-colons to separate the addresses. 

Main Parameter Purpose Required? 

/batch Tells Analysis Services to 
run the 
Stratum.Connector.exe in 
batch. 

Yes 

/ProcessType:ProcessTypeEnum Specifies the type of process 
that the batch process will 
run. Valid values for 
ProcessTypeEnum are: 

0 – Full 

1 – Standard 

2 – Post 

3 – Diagnostic 

4 – Limited 

5 – Trickle  

Yes 

/ProcessBy:MeasureGroupId 

 

This parameter only pertains 
to a process type 5 – Trickle 
process. It is the ID of the 
measure group(s) to be 
processed.  

Yes - The MeasureGroupId is 
required for process type 5 – Trickle 
process. Use semi-colons (;) as a 
separator to process more than one 
MeasureGroupId. For example, 
/ProcessBy:1;4;8, will process all 
years for measure groups 1,4, and 8. 

 

/ProcessBy:MeasureGroupId(YearValue) This additional YearValue 
option only pertains to 
process type 5 – Trickle 
process and 
implementations with 
Enterprise Edition of 
Analysis Services. 
YearValue represents the 
year(s) of the measure group 
to be processed.  

No - If you have the Enterprise 
Edition of Analysis Services, you can 
optionally specify what year(s) 
(YearValue) will be processed for the 
identified measure group. Use 
commas (,) as separators to specify 
multiple years. For example, 
/ProcessBy:1(2016,2017);4(2016,201
7);22 will process years 2016 and 
2017 for measure group 1, years 
2016 and 2017 for measure group 4, 
and all years for measure group 22. 

All years will be processed if you do 
not use the (YearValue) part of the 
parameter.  
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Optional Emails Parameters Purpose Required? 

This set of parameters and the next 
three sets are for overriding properties 
specified in the Emails tab of the 
Parameter Settings window of 
Stratum.Connector.  

1. /MailFrom:FromEmailAddress 

2. /MailSmtpServer:SmtpServer 

 

The parameters control the 
From address for the emails 
sent after each batch 
process and the server that 
manages the emails. 

 

No - By default, they are controlled 
from the Emails tab of the Parameter 
Settings window. Only use these 
parameters if you want to override 
the settings in that window.  

These parameters are for emails 
resulting from a completed process, 
where the cube is available after the 
process.  

1. /CubeAvailableEmailToAddress:Cub
eAvailableEmailToAddress 

2. /CubeAvailableEmailSubject:CubeAv
ailableEmailSubject 

3. /CubeAvailableEmailBody:CubeAvail
ableEmailBody 

4. /AttachProcessLogForCubeAvailable
:AttachProcessLogForCubeAvailable
Enum 

The email notifies recipients 
that a process completed 
and the cube is available. 
The email usually includes 
the process log file unless 
Connector was directed to 
exclude it. 

Valid values for the log file 
parameter are: 

0 – Attach log file to email 

1 – Do not attach log file 

No – See note above. 

If you use the EmailToAddress 
parameter and specify multiple email 
addresses, use semi-colons to 
separate the addresses. 

If any values for the Email 
parameters contain spaces, you will 
need to enclose the parameter and 
its values in double quotes. For 
example: 

“/CubeAvailableEmailSubject: Full 
Nightly Process Completed OK” 

These parameters are for emails 
resulting from a completed process, 
where the process locked the database. 

1. /CubeLockedEmailToAddress:CubeL
ockedEmailToAddress 

2. /CubeLockedEmailSubject:CubeLoc
kedEmailSubject 

3. /CubeLockedEmailBody:CubeLocke
dEmailBody 

4. /AttachProcessLogForCubeLocked:A
ttachProcessLogForCubeLockedEnu
m 

The email notifies recipients 
that a process completed but 
it locked the database. The 
email usually includes the 
process log file unless 
Connector was directed to 
exclude it. 

Valid values for the log file 
parameter are: 

0 – Attach log file to email 

1 – Do not attach log file 

No – See first Emails note above. 

If you use the EmailToAddress 
parameter and specify multiple email 
addresses, use semi-colons to 
separate the addresses. 

If any values for the Email 
parameters contain spaces, you will 
need to enclose the parameter and 
its values in double quotes. For 
example: 

“/CubeLockedEmailSubject: Full 
Nightly Process Resulted In Locked 
Cube” 

These parameters are for emails about 
key errors that occurred during a 
process. 

1. /KeyErrorEmailToAddress: 
KeyErrorEmailToAddress 

2. /KeyErrorEmailSubject: 
KeyErrorEmailSubject 

3. /KeyErrorEmailBody: 
KeyErrorEmailBody 

The email notifies recipients 
about the key error status for 
a process. The email usually 
includes the key errors log 
file unless Connector was 
directed to exclude it. 

Valid values for the log file 
parameter are: 

0 – Attach log file to email 

1 – Do not attach log file 

No – See first Emails note above. 

If you use the EmailToAddress 
parameter and specify multiple email 
addresses, use semi-colons to 
separate the addresses. 

If any values for the Email 
parameters contain spaces, you will 
need to enclose the parameter and 
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4. /AttachKeyErrorLog:AttachKeyErrorL
ogEnum 

its values in double quotes. For 
example: 

“/KeyErrorEmailSubject: Key Error 
Results” 

Optional Log Files Parameters Purpose Required? 

/LogVerbosity:LogVerbosityEnum 

 

Controls the level of detail 
for the information written to 
the processing log. 

0 – Normal 

1 – Debug 

Setting ‘0’ is recommended. 

No - By default, it is controlled from 
the Log Files tab of the Parameter 
Settings window. Only use this 
parameter if you want to override the 
setting in that window. 

 

/ProcessLogFolder:ProcessLogFolder Controls the location of the 
main log file for a batch 
process. 

No - See note above. 

/KeyErrorLogFolder:KeyErrorLogFolder Controls the location of the 
key error log file for a batch 
process. 

No - See first Log Files note above. 

/PostProcessTempFolder:PostProcessT
empFolder 

Controls the location of the 
temporary text file created 
for the Post Process phase 
(MembersN table updates) 
of a batch process. 

No - See first Log Files note above. 

Optional Key Error Parameters Purpose Required? 

This parameter and the next one are for 
overriding properties specified in the Key 
Errors tab of the Parameter Settings 
window of Stratum.Connector. 

/StopProcessOnKeyErrors:StopProcess
OnKeyErrorsEnum 

Determines if key errors will 
stop the batch process. Valid 
values are: 

0 – Continue process on key 
errors 

1 – Stop process on key 
errors 

No - By default, it is controlled from 
the Key Errors tab of the Parameter 
Settings window. Only use this 
parameter if you want to override the 
setting in that window. 

/KeyErrorLimit:KeyErrorLimit 

 

Determines how many key 
errors are permitted before 
batch processing will be 
stopped. Specify the limit 
value. This setting is only 
considered if the 
StopProcessOnKeyErrors 
parameter is set to 1. 

No – See note above. 

Optional General Parameters Purpose Required? 

This parameter and the next one are for 
overriding properties specified in the 
General tab of the Parameter Settings 
window of Stratum.Connector. 

Only applicable to a Full 
process. Determines if an 
aggregation is applied to the 

No - By default, it is controlled from 
the General tab of the Parameter 
Settings window. Only use this 



Copyright 2022 Silvon Software, Inc. All rights reserved. (Last Revised: July 2022)                 39 

/UseGroupBy:UseGroupByEnum  result set during processing. 
Valid values are: 

0 – No, do not perform 
aggregation 

1 – Yes, perform 
aggregation 

parameter if you want to override the 
setting in that window. 

/AddNewDimensions:AddNewDimension
sEnum  

 

Only applicable to a Full 
process. Determines if newly 
added dimensions will be 
selected for valid measure 
groups. Valid values are: 

0 – Add newly added 
dimensions to measure 
groups 

1 – Do not add newly added 
dimensions to measure 
groups 

 

No – See note above. 

Optional Planning Writeback 
Parameter For Trickle Processes 

Purpose Required? 

/ProcessWriteback:ProcessWritebackEn
um 

 

This parameter only pertains 
to a process type 5 – Trickle 
process. Use it to direct a 
Trickle process type to 
process the Analysis 
Service’s Writeback 
Partitions for the specified 
measure group(s). 

0 – No, do not process the 
Analysis Services Writeback 
Partitions. This is the default. 

1 – Yes, do process the 
Analysis Services Writeback 
Partitions. 

No – If not used, a Trickle process 
won’t process the Analysis Services 
Writeback Partitions for the specified 
measure group(s). No is the default 
behavior for a Trickle process.  

Set the parameter to 1 if you want 
the Analysis Services Writeback 
Partitions for the specified measure 
group(s) to be processed. 

Data Import Parameter Purpose Required? 

/AddMissingMemberForUCD:AddMissing
MembersForUserControlledData 

Determines if Connector will 
check user controlled data to 
determine if there are any 
missing Master File records. 
It there are, they will be 
automatically added to the 
appropriate Master Files. 
Applicable to all types of 
Connector processes and 
supports user controlled data 
functionality such as 
Stratum.Viewer’s Data 
Import.  

No - By default, it is controlled from 
the General tab of the Parameter 
Settings window. Only use this 
parameter if you want to override the 
setting in that window. 

If Data Import functionality is being 
used, make sure the parameter is 
selected in Connector or this batch 
command parameter is set to 1. 
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Valid values are: 

0 – Do not check for missing 
Master File members 

1 – Check for missing 
Master File members  

Master Data Import Parameters  Purpose Required? 

/LimitedProcessPendingUpdates:Limited
ProcessUCAUpdatesEnum 

This parameter only pertains 
to a process type 4 – 
Limited. Use it to direct a 
Limited process to check for 
then process any pending 
changes related to User 
Controlled Attributes such as 
new or edited User 
Controlled Attributes. 

Valid values for 
LimitedProcessUCAUpdates
Enum are: 

0 – No, do not process 
pending changes for User 
Controlled Attributes. 

1 – Yes, process pending 
changes for User Controlled 
Attributes. 

No - By default, it is controlled from 
the General tab of the Parameter 
Settings window. Only use this 
parameter if you want to override the 
setting in that window. 

Only set this to Yes in situations 
where it is okay if the Limited process 
is switched to Full process (a Full 
process means users won’t be able 
to access views in Stratum.Viewer 
until after the process is completed). 

/StandardProcessPendingUpdates:Stand
ardProcessUCAUpdatesEnum 

This parameter only pertains 
to a process type 1 – 
Standard. Use it to direct a 
Standard process to check 
for then process any pending 
changes related to User 
Controlled Attributes such as 
new or edited User 
Controlled Attributes. 

Valid values for 
StandardProcessUCAUpdat
esEnum are: 

0 – No, do not process 
pending changes for User 
Controlled Attributes. 

1 – Yes, process pending 
changes for User Controlled 
Attributes. 

No - By default, it is controlled from 
the General tab of the Parameter 
Settings window. Only use this 
parameter if you want to override the 
setting in that window. 

Only set this to Yes in situations 
where it is okay if the Standard 
process is switched to Full process (a 
Full process means users won’t be 
able to access views in 
Stratum.Viewer until after the 
process is completed). 

Discontinued Parameters  Purpose Required? 

As of Version 6.8, the following 
parameters from prior versions of 
Connector are no longer valid:  

• /MailTo:ToEmailAddress 

N/A  N/A – if you have batch processes 
that you set up prior to 6.8 that used 
these parameters and plan to use 
them for 6.8 processing, then adjust 
the email parameters based on the 



Copyright 2022 Silvon Software, Inc. All rights reserved. (Last Revised: July 2022)                 41 

• /MailSubject:EmailSubjectText 

• /MailBody:EmailBodyText 

current applicable set noted earlier in 
this table. 

Example Parameter Combinations 
Your batch command will need to reference the path to and name of the Silvon.Connector.exe file. For example, 
C:\Program Files\Silvon Software\Stratum Connector for Viewer\Silvon.Connector.exe\.      

Example Description 

C:\Program Files\Silvon Software\Stratum Connector for 
Viewer\Silvon.Connector.exe /batch /ProcessType:4 

Runs a Limited process. 

C:\Program Files\Silvon Software\Stratum Connector for 
Viewer\Silvon.Connector.exe /batch /ProcessType:5 /ProcessBy:1   

Runs a Trickle process for all years 
for measure group 1. 

C:\Program Files\Silvon Software\Stratum Connector for 
Viewer\Silvon.Connector.exe /batch /ProcessType:5 
/ProcessBy:3(2016);5(2015,2016)   

Runs a Trickle process for year 2016 
of measure group 3 and years 2015 
and 2016 of measure group 5.   

Note: Specifying a specific year is 
only supported if you are running 
Enterprise Edition of Analysis 
Services.   

Create Hierarchies from Attribute Relationships 

1.   Right-click the Dimensions node , and select Edit to open the Dimension Selection window. 

2.   Expand  the nodes for the dimension, hierarchy, and then for the level to which the desired attribute 
relationship belongs. 

3.   Click the attribute relationship. 

4.   At the bottom of the window, click the Create Hierarchy option. 

5.   Enter a name in the Hierarchy Name field. 

6.   Save  the changes and close  the window. 

7.   If you are setting up the database for the first time, continue with any remaining steps for setting up the 
application -- see Quick Start - Initial Setup of Application and Data . If you are editing the database, see When 
to use a Full, Limited, Post, Standard, or Trickle Process to determine what type of database process to run 
after making your changes. 

Edit Properties for Calculated Members 

1.   Right-click the Calculated Members node , and select Edit to open the Calculated Member Selection 
window. 

2.   Click a calculated member, and use the fields at the bottom of the window to edit its name, description, or 
format string. 
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3.   Save  the changes and close  the window. 

4.   When you are done with all edits to the database, see When to use a Full, Limited, Post, Standard, or Trickle 
Process  to determine what type of database process to run after making your changes. 

Edit Properties for Dimensions, Hierarchies, Levels, & Attribute Relationships 

1.   Right-click the Dimensions node , and select Edit to open the Dimension Selection window. 

2.   Navigate to the object in the window -- expand  the nodes for the applicable dimension, hierarchy, and/or 
level. 

3.   Click the object, and use the fields at the bottom of the window to edit its properties.  

• You can edit names and descriptions of dimensions, hierarchies, and levels. 

• You edit names of Corporate Controlled attributes and create hierarchies from them. See also Create 
Hierarchies from Attribute Relationships. 

• You can view properties for User Controlled attributes. Editing, removing, or creating hierarchies from this 
type of attribute is done using Stratum.Viewer’s Attribute Maintenance functionality.  

Note:  The Attribute Controlled By property tells you if an attribute is Corporate or User Controlled. See also 
Attribute Relationships. 

4.   Save  the changes and close  the window. 

5.   When you are done with all edits to the database, see When to use a Full, Limited, Post, Standard, or Trickle 
Process  to determine what type of database process to run after making your changes. 
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Edit Properties for Measures in Measure Groups 

1.   Right-click the Measure Groups node , and select Edit to open the Measure Group Selection window. 

2.   Navigate to the measure in the window -- expand  the node for its measure group and expand the Measures 
node within that group. 

3.   Click the measure, and use the fields at the bottom of the window to edit its name, description, or format string. 

4.   Save  the changes and close  the window. 

5.   When you are done with all edits to the database, see When to use a Full, Limited, Post, Standard, or Trickle 
Process  to determine what type of database process to run after making your changes. 
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Impact of Update Enabled Setting on Roles and Planning in Stratum.Viewer 
The Update Enabled setting in Stratum.Connector influences role and measure settings in Stratum.Viewer related 
to planning functionality. A group must have its Updated Enabled property selected before Stratum.Viewer 
administrators can activate a Planning Allowed property for them in Stratum.Viewer. Also, administrators can only 
give users Update authority to measures for planning purposes if the measure group for the measures in 
Stratum.Connector are Updated Enabled. 

Example Impact on Roles 
The next image shows an example of the Role Maintenance window in Stratum.Viewer. The circled measure 
groups (Categories) do not have Update checkboxes because they were not Update Enabled in 
Stratum.Connector. Stratum.Viewer users cannot be given Update access to measures in any of those groups. The 
remaining measure groups, including Budget and Forecast, have Update checkboxes because they were Update 
Enabled in Stratum.Connector. By default, the Update checkboxes for those measure groups will be de-selected in 
the Role Maintenance window for all roles. Stratum.Viewer security administrators can give Update access to any 
measures in those groups by selecting their Update checkboxes. The second image shows a role that has been 
given Update access to a few Forecast measures.  
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Here is the Measure Group Selection window in Stratum.Connector that corresponds to the previous images. This 
window is where the Update Enabled property is controlled. Notice the Update Enabled checkbox is selected for 
Forecast. The same thing was done for Budget, Cart Activity, and Deductions. 
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Changing the Update Enabled setting will change the Update checkboxes in the Stratum.Viewer Role Maintenance 
window. Here is the Measure Group selection window after Update Enabled was de-selected for Forecast. 
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After that change was saved and the Analysis Services database was processed, the Update checkboxes for 
Forecast were removed for all roles in Stratum.Viewer and no users will be able to update Forecast measures. 
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Run Master File Commands and Enable OLAP Parameter/Switch 
These tasks must be performed before you access Stratum.Connector for the first time and process its Analysis 
Services cube and database.  

1.   Run the LOADOLAP Master File command to create a MASTERxx table for all dimension values. 

• For IBM i storage servers, run the DALOADOLAP command. 
• For Windows storage servers, run the GILOADOLAP command. 

2.   Run the CRTOMAST Master File command to create and populate the MASTxx tables. 

• For IBM i storage servers, run the DACRTOMAST command. 
• For Windows storage servers, run the GICRTOMAST command. 

3.   Add the CRTOMAST Master File command to the end of the nightly load program for Stratum to maintain the 
MASTxx tables. 

4.   Turn on the OLAP parameter/switch to maintain the MASTERxx tables during any nightly Stratum database 
load or change set process.  

• For IBM i storage servers, set the Maintain OLAP Master parameter for the DALOAD, DACHGSET, and 
DAGRPCHG commands to 1. 

• For Windows storage servers, set the /OLAP switch for the GISLSDRV, GIACSDRV, and GIGRPCHG 
commands to 1. 

Once you have completed these steps, you can proceed with the set up of Stratum.Connector and processing its 
Analysis Services database. See Quick Start - Initial Setup of Application and Data. 
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When to Use a Full, Limited, Post, Standard, or Trickle Process 
This table shows examples of when to use the types of processes that are available in Stratum.Connector: Full, 
Limited, Post, Standard, or Trickle. 

Planning functionality in Stratum.Viewer needs to be considered when initiating a process. A Full process* of the 
Analysis Services database by Stratum.Connector will clear all planning writeback partitions and writeback tables. 

*Note: If a Standard process detects any meta data changes made in Stratum.Connector, it will automatically 
execute a Full process. 

Type of Process: Use this Type When: 

Full  • You are processing the Analysis Services database for the first time. 
• Changes that impact Stratum meta data have been made in Stratum.Connector, 

Stratum.Administration, or Stratum.Viewer’s Attribute Maintenance app. 
• Your Stratum.Connector and Stratum.Viewer applications have been upgraded. After 

upgrades, a Full process should be executed to make sure all aspects of the upgrade 
have been implemented.  

Note: During a Full process, Stratum.Viewer users cannot run views and should not use 
Stratum.Viewer administrative functions. 

Limited 
 

• You need to refresh the Stratum.Connector Analysis Services cube with changed 
Stratum warehouse and master file data with minimal interruptions to users.*  

• No changes that impact Stratum meta data have been made in Stratum.Connector or 
Stratum.Administration**. If there are changes from those two apps, the Limited 
process will not run and a separate Full process must be run.  

*Note: During a Limited process, users can continue running views, editing views, and 
using other features and windows in Stratum.Viewer. Users will not be locked out during 
the process unless they have roles that use dynamic user lists or migrated 
Stratum.Planner user lists to secure a dimension that has changed master file data. 

**Note: Settings in Connector allow you to tell the Limited process to ignore meta data 
changes that originated from the Stratum.Viewer Attribute Maintenance.  

Post • You have calculated members that have been changed, added, or removed (de-
selected) in Stratum.Connector. 

• You have set up dynamic user lists with the “Batch Process” property enabled in 
Stratum.Viewer. 

• You have new or updated Stratum.Planner user lists that need to be imported into 
Stratum.Viewer. 

• You have updated the Stratum.Planner Import Calendar. 

Note: During a Post process, Stratum.Viewer users cannot run views and should not use 
Stratum.Viewer administrative functions. 

Standard • You need to refresh the Stratum.Connector Analysis Services cube with changed 
Stratum warehouse and master file data.*   

• No changes that impact Stratum meta data have been made in Stratum.Connector, 
Stratum.Administration, or Stratum.Viewer’s Attribute Maintenance app. If there are 
meta data changes from Connector or Stratum.Administration, a Standard process will 
automatically run a Full process. If there are meta data changes from Viewer’s 
Attribute Maintenance app, a setting in Connector lets you control whether or not the 



Copyright 2022 Silvon Software, Inc. All rights reserved. (Last Revised: July 2022)                 51 

Standard process will check for changes and switch to a Full process to handle the 
changes.** 

*Note: During a Standard process, Stratum.Viewer users cannot run views and should not 
use Stratum.Viewer administrative functions. A Standard process is typically done at a 
time when users won’t be using Stratum.Viewer – for example, the process is done as part 
of a nightly, regularly scheduled update of all your Stratum data. 

**Note: Settings in Connector allow you to tell the Standard process to switch to a Full 
process automatically if it finds meta data changes that originated from the Stratum.Viewer 
Attribute Maintenance app. Only enable that setting if you know the timing is okay for a 
Full process to occur since that type of process impacts user access to views and 
administration functions in Viewer until it has completed. 

Trickle • You have a specific set of data that needs to be updated during the course of your 
business day and need to do so with minimal disruption to Stratum.Viewer users.  

• No changes that impact Stratum meta data have been made in Stratum.Connector or 
Stratum.Administration. If there are changes, the Trickle process will not run and a 
separate Full process must be run. 

• Pending meta data changes from Stratum.Viewer’s Attribute Maintenance are ignored 
by Trickle processes. 

 

 

Definitions 

Attribute Relationship 
Attribute relationships provide supplementary, descriptive information about levels. For example, a Customer level 
may have members (Customers) with attribute relationships such as address, contact person, long description, 
phone number, and region. You can see attribute relationships in the Dimension Selection window. The following 
example shows two attribute relationships for the Product Family level ( ). 

 

How To Use Attributes In Viewer 

Attribute relationships can be used in Stratum.Viewer several ways, such as displayed on rows and columns of 
views, used for filtering purposes, and used to build user list expressions. They are also used as display columns 
and for searching purposes in the Select and Advanced Select Members windows within Stratum.Viewer. 
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Types Of Attributes 

Attribute values are controlled either on the corporate side of things in Stratum.Server or using Stratum.Viewer’s 
Master Data Import functionality. Both types can be used in the same way in Viewer. The Attribute Controlled By 
property in the Dimension selection window tells you if an attribute is Corporate or User Controlled. Details follow 
about how and where to maintain each type. 

Corporate Controlled Attribute Relationships – Their values originate from your Corporate busines systems and 
are stored in your Stratum.Server database. They can be selected for use and maintained in Stratum.Connector. 
Change their names, create hierarchies from them, and select or deselect them to control availability in Viewer. The 
next image shows the CPrnt City attribute relationship, which is Corporate controlled and belongs to the Customer 
Parent level.  

 
User Controlled Attribute Relationships – Their values originate from an Excel spreadsheet and become part of 
Stratum using Stratum.Viewer’s Master Data Import functionality.* Use Stratum.Viewer’s User Controlled Attribute 
Maintenance functionality to define attributes, maintain attribute properties, create or remove hierarchies based on 
the attributes, or delete the attributes. In Connector, you can view their properties including seeing any hierarchy 
created from the attribute. The next image shows a User Controlled attribute for the Customer Parent level. It was 
created in Attribute Maintenance, and a hierarchy was also created for it there.  

*Note: User Controlled Attribute Maintenance functionality is only available for implementations running 
Stratum.Server on a Windows SQL server and that have a license for the Stratum Analyst Hub. It is not available 
for implementations running Stratum.Server on an IBM i Server.  
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Calculated Member 
Calculated members are measures derived from other measures. They represent calculations between pieces of 
data or groups of data. The calculation can include additions, subtractions, multiplications, divisions, and so forth. 
An example is an Actual Sales Calc Values Discount Amount calculated member that uses measures from the 
Actual Sales measure group in its calculation. Calculated members behave the same as measures in 
Stratum.Viewer. Stratum.Administration calculated category values (from the Stratum.Server database) become 
calculated members available for selection in your Stratum.Connector environment. 

Cube 
A cube represents logical groupings of Stratum.Server data for use with Stratum.Viewer. These groups are made 
up of partitions, dimensions, and measures based on Stratum.Server Structure Code definitions. 

Cubes contain the Stratum data in Analysis Services-compliant format for use by Stratum.Viewer. The data is used 
for Stratum.Viewer roles, user lists, measure items, and views. 

Database 
The database for Stratum.Connector is an Analysis Services database that stores Analysis Services-compliant 
meta data and Master File data. The cube in the database defines sets of data that act as sources of data for 
defining roles, building user lists, and building views in Stratum.Viewer. 
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Dimension 
There is a 3-part Analysis Services structure of information within Stratum.Connector that includes dimensions, 
hierarchies, and levels. Dimensions contain at least one hierarchy, which in turn contain at least one level, which in 
turn contain members. You can see an example of this structure in the Dimension Selection window. The following 
example shows a Product Family dimension ( ) with a Product Family hierarchy ( ) and level ( ). 
Stratum.Connector takes care of translating dimensions from your Stratum.Server database into the 3-part, 
Analysis Services structure of Dimension.Hierarchy.Level. 

 

Hierarchy 
There is a 3-part Analysis Services structure of information within Stratum.Connector that includes dimensions, 
hierarchies, and levels. Hierarchies belong to dimensions and contain at least one level, which in turn contain 
members. You can see an example of this structure in the Dimension Selection window. The following example 
shows a Product Family hierarchy ( ) and level ( ). The hierarchy belongs to the Product Family dimension (
). 
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Level 
There is a 3-part Analysis Services structure of information within Stratum.Connector that includes dimensions, 
hierarchies, and levels. Levels belong to hierarchies and contain members. You can see an example of this 
structure in the Dimension Selection window. The following example shows a Product Family level ( ), which 
belongs to a Product Family hierarchy ( ) from the Product Family dimension ( ). When the level is used in 
Stratum.Viewer views, you will see level members such as Frozen Juice, Frozen Fruit, Fresh Beef, and Fresh Pork. 
Levels selected for your Analysis Services cube can be used in Stratum.Viewer several ways, such as displayed on 
rows and columns of views, used for filtering purposes, and used to build user list expressions. 

Stratum.Connector takes care of translating dimensions from your Stratum.Server database into the 3-part, 
Analysis Services structure of Dimension.Hierarchy.Level. 

 

Measure 
Measures are the basic units of data for your dimensions, hierarchies, and levels. Stratum.Connector organizes 
measures into measure groups based on their Stratum.Server Structure Code. 

Measures selected for your Analysis Services cube can be used in Stratum.Viewer to create and insert measure 
items into your views. 

Measure Group 
Stratum.Connector organizes Stratum.Server data into measure groups. A measure group is made up of partitions 
(years), dimensions, and measures based on Stratum.Server Structure Code definitions. Examples of measure 
groups are Accounts Payable - Open, Actual Sales, Budget, Daily Sales, Forecast, Inventory, and Open Orders. 

Partition 
A partition is created for each year of data for a measure group. The number of partitions is determined by the 
years of data that exist in the Stratum.Server database associated with the Structure Code. 
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